
ЛАБОРАТОРНА РОБОТА  №3.  

Тема: «Обробка  відео-аудіо інформації на персональному комп’ютері та збереження у цифровому 

вигляді (SonyVegas).» 

Мета: вивчити можливості комп’ютера для створення, збереження і відтворення аудіо- та відео- файлів; надати 

навички створення слайдів-фільмів і відео кліпів. 

Професійна спрямованість: теоретичні знання та практичні уміння з даної теми дозволять вчителю 

оптимізувати навчально-виховний процес, оскільки уміле використання засобів динамічної проекції значно покращує 

основні етапи навчально-пізнавальної діяльності учнів. 

План: 

1. Монтаж відео. 

2. Титри. 

3. Спецефекти. 

4. Вивід змонтованого фільму. 

5. Різноманітні формати відео. 

6. Виконання роботи. 

Рекомендована література: 

1. Довідкова система SonyVegas. 
2. Таргонская В.В. Новые компьютерные технологии в образовании: мультимедийный сетовой обучающий комплекс 

HICLASS II. В сб. "Нові інформаційні технології навчання в учбових закладах України". Одеса.2001.-С.111-118.  

3. Чернилевский Д.В. Дидактические технологии в высшей школе: Учеб. пособие для вузов. – М.: ЮНИТИ-ДАНА, 2002. – 

437 с. 

Інструкція до виконання: 

Для виконання поставлених в лабораторній роботі завдань необхідно мати мультимедійний комп’ютер, програмне 

забезпечення (операційна система –Win2k\XP\Vista, програму по обробці відео-аудіо інформації – Sony Vegas). Окрім 

даної програми по обробці відео-аудіо інформації існують і інші, наприклад: Windows Movie Maker, Video Studio, 

Pinacle Studio, Hollywod FX та ін.. 

 
Рис. 2. Інтерфейс програми Sony Vegas. 

Програма Vegas дозволяє створювати проекти фільмів з великою кількістю доріжок. В процесі створення фільму 

можна накладати одне зображення на інше, вставляти титри, добавляти фонову музику і закодовані коментарі.  Нові 

доріжки створюються автоматично в момент розміщення компонентів фільму (відеоепізоду, звукового фрагменту, 

титрів або графічного файлу) у вікні Timeline (Вікно монтажу). Можливості програми: працює в режимі реального 

часу; має біля двохсот шаблонів переходу (Шаблони переходів представлені у вигляді ярликів, розміщених в правій 



 

 
Рис. 2. Створення переходу 

 
Рис. 3. Transitions (Переходи). 

частині вікна вкладки Transitions (Переходи)); має велику кількість спецефектів розміщених на вкладці Video FX 

(Спецефекти). 

1. Монтаж відео 

Розпочинати монтаж фільму необхідно з розміщення відеофайлів у вікні Timeline (Вікно монтажу). Добавити 

файли в проект можна прямо із вікна Explorer (Провідник), але в даній програмі передбачено більш зручний 

інструмент, який розміщений на вкладці Media Pool (Файли проекту) вікно із вкладками. Дана вкладка служить 

своєрідним контейнером, куди можна помістити посилання на всі файли, необхідні для створення майбутнього 

фільму. Розмістити посилання у вкладці Media Pool (Файли проекту) можна також за допомогою команди головного 

меню File → Import → Media (Файл → Імпорт → Файли) також відкривається діалог Import(Імпорт) для імпорту 

файлів в Media Pool (Файли проекту). При видалені файлів із Media Pool (Файли проекту) видаляються лише 

посилання на файли. Самі ж файли з жорсткого диску не видаляються. 

Папка Media Bins (Корзини файлів) на початковому етапі не містить ніяких компонентів. В цій папці можна 

створити необмежену кількість підпапок і розсортувати файли проекту по цим підпапкам. Для створення нової 

корзини файлів потрібно правою кнопкою миші на папці Media Bins (Корзини файлів) в контекстному меню вибрати 

команду Create New Bin (Створити нову корзину), а потім ввести назву для нової папки. 

Обрізати або розбити на фрагменти кліпи можна на будь-якому етапі створення фільму до завершення виводу 

фільму в файл або на льоту. Але зручніше всього обрізати кліпи перед початком монтажу фільму у вкладці Trimmer 

(Обрізка), яка має всі необхідні інструменти для обрізки кліпу і розбивки на окремі фрагменти. 

Безпосередній монтаж фільму відбувається у вікні Timeline (Вікно монтажу). Проект фільму може складатися із 

однієї або декількох звукових і відеодоріжок. На відео доріжках розміщуються відео кліпи, картинки і титри, а на 

звукових доріжках – звуковий супровід фільму.  

Щоб помістити файл в проект фільму необхідно: 

– вибрати вкладку Media Pool (Файли проекту); 

– встановити вказівник миші на назві кліпу; 

– утримуючи кнопку миші, перемістити даний файл у вікно Timeline (Вікно монтажу); 

– відпустити кнопку миші. 

Для того, щоб між кліпами у даному вікні не утворювався пустий простір перед розміщенням кліпів у вікні 

монтажу потрібно активувати кнопку  Auto Ripple (Автоматична підгонка). Для переміщення кліпів у вікно 

монтажу можна за допомогою подвійного клацання лівої кнопки миші. 

В момент, коли відбувається зміна фрагментів, в кадрі відображається різка зміна вмісту кадру, що не завжди 

добре виглядає, для цього в програмі передбачена можливість автоматичного створення переходів Crossfade 

(Монтажний перехід) між кліпами. Переходи можуть застосовуватись не тільки для згладжування моменту зміни 

сцен, а, навпаки, – для підкреслення зміни сюжетної лінії фільму. Переходи можуть застосовуватись не тільки до відео 

кліпів, але і до титрів, розміщених в проекті фільму. 

У вікні монтажу Timeline (Вікно монтажу) є можливість вставки кліпів у середину інших кліпів. Присутня 

можливість обрізки і видалення фрагментів кліпів. Якщо кліп розтягувати у даному вікні при натиснутій клавіші 

 Сtrl , а курсор миші прийме вигляд  то швидкість відтворення кліпу сповільниця.  

Для того щоб створити перехід між кліпами потрібно: 

– встановити курсор поточної позиції редагування між кліпами. Для більш точного встановлення поточної 

позиції редагування між кліпами потрібно збільшити горизонтальний 

масштаб проекту; 

– натиснути кнопку миші на кліпі розміщеного правіше і 

утримуючи кнопку миші, перемістити кліп вліво таким чином, щоб ліва 

частина цього кліпу частково перекрила собою праву частину кліпу 

попереднього сюжету (Рис. 2). 

При переміщенні одного кліпу на другий у місці, де кліпи 

перекриваються, створюється перехід. Тривалість переходу визначається 

тривалістю перекриття кліпів. 

По замовчуванню програма Vegas у місці перекриття кліпів створює 

перехід Crossfade (Монтажний перехід). Це найбільш поширений 

перехід, який застосовується в кіно і утворюючий ефект плавного 

зникнення попередньої сцени в плавно з’являючої нової сцени. Для 

створення інших переходів необхідно виконати 

наступні дії: 

– натиснути мишкою на вкладці Transitions 

(Переходи) у вікні із вкладками. На цій вкладці 

знаходяться біля двохсот самих різноманітних 

переходів, які можна застосовувати у фільмах (Рис. 3); 

– вибрати в лівій частині вікна Transitions 

(Переходи) групу переходів, наприклад, Clock Wipe 

(Часове витиснення). Переходи цієї групи створюють 

ефект концентричної зміни сцени,  тобто кінець сцени 

стирається по кругу, подібно ходу годинникової 

стрілки, відкриваючи наступну сцену; 



– в правій частині вікна Transitions (Переходи) натиснути кнопкою миші на значку переходів Counter 

Clockwise, Hard edge (Проти часової стрічки з різким краєм). 

– утримуючи кнопку миші, перемістити значок переходу Counter Clockwise, Hard edge (Проти часової стрічки 

з різким краєм) в область перекриття першого і другого кліпу. Вказівник миші прийме вигляд . Відпустити кнопку 

миші. На екрані з’явиться діалог Video Event FX (Ефект відео-фрагменту) (Рис. 4). Закрити вікно. 

Діалог Video Event FX (Ефект відео-фрагменту) існує для зміни деяких параметрів переходу. Кожен перехід має 

свої параметри, які відрізняються від інших переходів. 

 
Рис. 4.Video Event FX (Ефект відео-фрагменту). 

Будь-який перехід всередині фільму також можна замінити ефектом Fade (Затухання). В цьому випадку 

попередня сцена буде плавно затухати, і одночасно наступна сцена буде плавно з’являтись на екрані. 

Для заміни переходу ефектом Fade потрібно: 

– клацнути правою кнопкою миші на значку  Transition Properties (Властивості переходу); 

– в контекстному меню вибрати Fade Type (Тип затухання) і в списку, який розкривається вибрати параметр 

ефекту (Рис. 5). 

 
Створення відео ряду фільму – найбільш важкий процес, який займає дуже багато часу. Кожен змінений 

фрагмент краще продивитись у вікні попереднього перегляду і, у випадку неправильного зробленого кроку, 

повернутись назад з допомогою команди Edit → Undo (Правка → Відмінити).  

В процесі створення фільму рекомендується періодично зберігати проект. 

2. Титри 

Титри у фільмі можуть застосовуватись для виводу на екран назви фільму, списку учасників і авторів фільму. 

Титри можуть бути виведені на екран не тільки на початку і кінці фільму, але і в будь-якій частині фільму для 

повідомлення певної інформації. 

Програма Vegas дозволяє створювати титри двох типів: 

1. Статичні титри. Ці титри виводяться на екран нерухомими. Однак з допомогою створюваних ключових 

кадрів можна заставити ці кліпи рухатись у кадрі. 

2. Титр прокрутки. Такі титри можуть прокручуватися по вертикалі або горизонталі.  

Титри можуть бути виведені на екран в якості окремих кадрів фільму або можуть бути накладені на відео-

зображення. В останньому випадку для розміщення титрів створюється окрема відеодоріжка, а фон титрів робиться 

прозорим. 

Створення початкового титру, який буде містити назву фільму та накладений на відео зображення потребує 

додаткової відео-доріжки. Для цього потрібно: 

– відключити режим Auto Ripple (Автоматична підгонка) клацнувши мишкою на кнопці . Кнопка 

повернеться у віджате положення; 

– вибрати команду меню Insert → Video Track (Вставка → Відео-доріжка). У вікні Timeline (Вікно монтажу) 

з’явиться нова відео доріжка, а у вікні Track List (Список доріжок) відобразиться панель керування властивостями 

нової відео-доріжки. Нова відео доріжка повинна розміщуватися вище існуючої доріжки з відео-кліпами. Зображення 

відео фрагменту, розміщеного на верхній відео-доріжці, завжди накладається на зображення кліпу нижньої доріжки;  

– Вибрати команду меню Insert → Text Media (Вставка → Титр). На екрані з’явиться діалог Video Event FX 

(Ефект відео-фрагмента) (Рис. 6). 



 
Рис. 6. Діалог Video Event FX 

(Ефекти відеофрагменту) 

Якщо нова відео-доріжка розміщена нижче 

доріжки з відео кліпами, потрібно клацнути мишкою 

на панелі керування властивостями нової відео 

доріжки у вікні Track List (Список доріжок) і, 

утримуючи кнопку миші, перемістити нову доріжку в 

позицію вище доріжки з кліпами. 

За допомогою Елементів діалогу Video Event FX 

(Ефекти відео-фрагменту) створюємо статичний 

титр і встановлюємо параметри: тип, колір і розмір 

шрифту. 

На вкладці Edit (Правка) діалогу Video Event 

FX (Ефекти відео-фрагменту) в полі введення тексту 

потрібно ввести назву фільму. 

У вибірковому списку вибрати потрібний 

шрифт. 

Вибрати розмір шрифту у вибірковому 

списку розміру шрифта. 

Колір шрифту та фон міняються мишкою на 

вкладці Properties (Властивості) діалогу Video Event 

FX (Ефекти відео-фрагменту). Вміст вікна зміниться, 

і відобразиться група елементів керування 

властивостями шрифту і фону титру. 

Титри прокрутки можна створити на прикладі 

завершального титру. Для цього необхідно: 

– клацнути мишкою на кнопці  Go to End 

(Перейти в кінець), який знаходиться в нижній 

частині вікна монтажу. Курсор поточної позиції редагування поміститься в кінець проекту; 

– вибирати вкладку Media Generators (Генератори файлів) у вікні із вкладками. (В лівій частині вікна Media 

Generators (Генератор файлів) розміщений список груп шаблонів, а в правій частині вікна – шаблони, які містяться у 

вибраній групі. В цьому вікні містяться не лише компоненти для створення прокрутки титрів, але і різноманітні 

фонові малюнки, текстури і градієнти, які можна використовувати в якості фону до титрів); 

– в лівій частині вікна Media Generators (Генератор файлів) вибрати групу Credit Roll (Прокрутка списку 

учасників). В правій частині з’явиться список шаблонів титрів, розміщених у даній групі; 

– потрібно клацнути мишкою і утримуючи кнопку миші на шаблоні Plain Scrolling on Black (Плавна прокрутка 

на чорному), перемістити титр на доріжку з кліпами в самий кінець проекту. Вказівник миші прийме вигляд ; 

– при відпусканні кнопки миші на екрані з’явиться діалог Video Event FX (Ефект відео-фрагмента) (Рис. 7); 

 
Рис. 7. Діалог Video Event FX (Ефект відео) 

для налаштування прокрутки титрів. 

– в даному діалозі можна змінити параметри прокрутки титру та закрити дане вікно натиснувши на кнопку  х  

у правій верхній частині вікна. 

Статичні титри можна „оживити”, якщо змінити властивості титрів в процесі виводу на екран на різних ключових 

кадрах. Ключовий кадр – це тимчасова мітка, яку можна створити, щоб змінити будь-які властивості титру в даній 

точці. Можна створити багато ключових кадрів, тим самим керуючи поведінкою титру на екрані. Наприклад, для 



статичного титру можна створити ефект плавної зміни кольору шрифту або фону, масштабу тексту або положення 

титру в кадрі. 

При створенні ключових кадрів натискаємо на початковому титрі правою кнопкою миші і  у контекстному меню, 

яке з’явилось вибраємо команду Edit Generated Media (Редагувати генерований файл). На екрані з’явиться діалог 

Video Event FX (Ефект відеофрагмента). 

Нижню частину даного діалогу займає вікно Keyframe controller (Вікно управління ключовими кадрами) (Рис. 

8), яке нагадує Timeline (Вікно монтажу). У цьому вікні знаходиться лінійка і курсор поточної позиції редагування. У 

вікні Keyframe controller (Вікно управління ключовими кадрами) діалогу Video Event FX (Ефект відеофрагмента) 

створюються ключові кадри. 

 
Рис. 8. Вікно Keyframecontroller (Вікно керування ключовими кадрами) 

Для прикладу можна розглянути використання ключових кадрів і зміни властивостей титру в цих точках, 

виконавши наступні дії: 

– у вікні Keyframe controller (Вікно управління ключовими кадрами) діалогу Video Event FX (Ефект відео-

фрагмента) потрібно натиснути клавішу  Last Keyframe (Кінець ключових кадрів) для переходу в кінець титру, 

створити ключовий кадр клацнувши мишкою на кнопку  Create Keyframe (Створити ключовий кадр). Ключові 

кадри позначаються ромбами, перший ключовий файл створюється завжди автоматично; 

– натиснути мишкою на ключовому кадрі, який знаходиться в кінці лінійки; 

– на вкладці Effects (Ефект титру) в полі Outline вибрати колір лінії синій; 

– у вікні Keyframe controller (Вікно управління ключовими кадрами) перейти на початок титру натиснувши 

клавішу  First Keyframe (Початок ключових кадрів); 

– натиснути мишкою на ключовому кадрі, який знаходиться на початку лінійки; 

– на вкладці Effects (Ефект титру) в полі Outline вибрати колір лінії червоний та закрити вікно діалогу. 

Створивши титри до фільму, перш ніж приступати до наступного етапу роботи з проектом, рекомендується 

продивитися у вікні попереднього перегляду весь проект і, якщо потрібно, внести корективи. 

3. Спецефекти 

Велика кількість модулів звукових і відео ефектів, які є в програмі Vegas, дає можливість відкоригувати дефекти 

зображення та звуку, а також прикрасити майбутній фільм і окремі фрагменти фільму. 

Шаблони різноманітних відео ефектів програми Vegas розміщені на вкладці Video FX (Відео-ефекти). Для 

зручності пошуку потрібного модуля ефектів шаблони об’єднані в групи, назва яких визначає характер дії ефектів. 

Шаблони відео-ефектів є у вигляді анімаційних значків, які дозволяють попередньо переглянути функцію модуля 

ефекту.  

Будь-який модуль ефекту містить допоміжні налаштування, за допомогою яких можна змінити деякі параметри. 

А з допомогою ключових кадрів можна змінювати дію 

звукового або відео-ефекту. 

4. Вивід змонтованого фільму 

Для збереження змонтованого відеофільму 

необхідно вибрати команду меню File → Render as 

(Файл → Прорахувати як). На екрані з’явиться діалог 

Render as (Прорахувати як) (Рис. 9). 

 

В відкритому списку Папка (Folder) діалогу 

Render as потрібно вибрати диск і папку, куди буде  

збережений створений відеофайл  

В текстовому полі Ім’я файлу (File Name) 

вводиться  назва відео файлу 

Відкрите поле Тип файлу (Output format) 

містить список форматів створюваних відео файлів.  

Інші клавіші вікна: 

Template - Шаблон 

Custom – Налаштувати 

Натиснувши клавішу Custom  потрапляємо в 

діалогове вікно Custom Template (Налаштування 

шаблону) в якому ми маємо можливість налаштувати 

параметри відео та звуку нашого шаблону  

Після налаштування шаблону потрібно зняти 

галочку з Render looр rеgion  only (Прорахувати тільки 

виділений фрагмент) та  натиснути клавішу Зберегти 

(Save). Почнеться збереження фалу (Рис. 10).  

 
Рис. 9. Діалог Render as (Прорахувати як). 

 



 
Рис. 10. Процес збереження файлу 

Напис Rendering complete (Прорахунок закінчено) вкаже нам на завершення процесу збереження. В нижній 

частині ділового вікна стануть активні дві кнопки: Open folder (Відкрити папку) та Open (Відкрити) 

5. Різноманітні формати відео 

Формати, що забезпечують компресію із втратою якості й не мають настроювання у відсотках якості, а тільки 

по потоку даних у секунду. 

MPEG-1 Стандарт розроблений в 1992 році з урахуванням можливостей 2-х швидкісних CD-ROM і 486 

комп'ютерів. 

MPEG-2 Стандарт прийнятий в 1994 році. Первинно розроблявся для цифрової передачі відео віщальної 

якості. Використається в DVD, цифровому TV і HDTV. 

MPEG-3 Призначався для телебачення високої чіткості (HDTV), але пізніше став частиною стандарту MPEG-

2 і окремо тепер не згадується. 

MPEG-4 Стандарт розрахований на дуже низькі потоки даних для застосування у відеотелефонах, 

мультимедійній електронній пошті, електронних інформаційних виданнях і т.п. 

MP3 Повна назва - MPEG Audio Layer 3. Призначений тільки для стиску аудіо, використовуючи компресію із 

втратами (з вихідного матеріалу віддаляється інформація, слабко сприймана людським вухом). Уважається кращим по 

співвідношенню якість / обсяг.  

Video CD (VCD) Стандарт запису відео у форматі MPEG-1 на звичайний Compact Disk (діаметр 120 мм, 

товщина 1.2 мм, одна інформаційна сторона). Один диск звичайно дозволяє зберігати до 74 хвилин відео, якість 

порівнянна з VHS стандартом. Для відтворення досить одношвидкісного CD-ROM.  

Відео зображення (mpeg-1): 

PAL - 352x288 25fps 

NTSC - 352x240 29.97fps 

Нерухоме зображення (jpeg):  

PAL - 704x576 

NTSC - 704x480 

Звук:  

Цифровий двухканальный Hi-Fi стерео звук з можливістю кодування Dolby Surround. Динамічний діапазон 

досягає 70d. Стиск із використанням алгоритму MPEG для Audio із приблизним коефіцієнтом стиску 1:5 (втрати 

якості суб'єктивно 5..6% стосовно Audio CD, можна співвіднести до MP3). 

Виконання роботи 

1. Увімкнути комп’ютер. 

2. Дочекатись завантаження операційної системи. 

3. Запустити програму Sony Vegas. 

4. Завантажте по черзі у наступному порядку файли а.avi, b.ave, c.avi, у вікно монтажу програми Vegas. Всі файли, 

які необхідні для виконання лабораторної роботи розміщені на сайті www.tzn.at.ua у вкладці «Матеріали до 

лаб.». 

5. Створити початковий титр, який буде містити назву фільму та накладений на відео зображення із 

використанням додаткової відеодоріжки. Назва фільму має містити назву лабораторного заняття, номер 

варіанту, дату (dd.mm.yyyy) виконання роботи. 

6. За допомогою ключових кадрів „оживити” текст титру. 

7. Завершальний титр створити у вигляді прокрутки відповідно варіанту. Текст завершального титру має містити 

прізвища студентів, що виконували дану роботу. 

8. Між кліпами та титрами створити переходи згідно варіанту додатку №1. 

9. Зберегти проект з ім’ям, що має вигляд: Grupa_NN_Prizvicshe.veg, де NN – номер групи, Prizvicshe – прізвища 

студентів латинськими літерами, що виконували дану роботу. 

10. Змонтований відеофільм зберегти як готовий відеоролик з ім’ям, що  повинно мати вигляд: 

Grupa_NN_Prizvicshe.avi, де NN – номер групи, Prizvicshe – прізвища студентів латинськими літерами, що 

виконували дану роботу. При збереженні використати кодек відео XviD MPEG-4 Codec, а для звуку MPEG 

Layer-3 з атрибутами 96 kBit/s, 44,100 Hz, Stereo. 

11. Результати виконаних робіт пред’явити викладачу. 

Поточні контрольні запитання 

1. Призначення програми Sony Vegas та її можливості, перелічіть ще декілька подібних програм аналогічній до 

даної програми. 

2. Переходи та їх застосування. 

3. Робота з титрами (види титрів, їх коротка характеристика). 

4. Поняття ключового кадру та його використання. 

http://www.tzn.at.ua/


5. Призначення спецефектів, що застосовуються в програмі Vegas. 

6. Формати збереження відео-аудіо інформації.  

 

Додаток №1 

В-

нт 

Робочі 

файли 

Переходи (Transitions) 

Завершальний титр з використанням 

генератору файлів 

(Media Generators) 

група переходів → перехід група файлів → перехід файлу 

1  a.avi,  

 b.avi,  

 c.avi. 

3D Bins → Simple 

Clock Wipe → ClockWise,Soft Edge 

Swap → Swap Left 

Credit Roll → Plain Scrolling on Black 

2  a.avi,  

 b.avi,  

 c.avi. 

Zoom → Zoom In, Center 

Squeeze → Vertical In, Red 

Linear Wipe → Top-Left, Diagonal… 

Credit Roll → Timed, Fade on Black 

3  a.avi,  

 b.avi,  

 c.avi. 

Page Loop → Top-Left, Medium Loop 

Page Peel → Top-Left, Medium Fold 

Split → Push, Out, Center 

Credit Roll → Timed, Zoom In/Out on Blue 

4  a4.avi,  

 a.avi,  

 b.avi,  

 c.avi. 

Iris → Circle, Out, Center 

Cross Effect → Cross Zoom A/B 

Barn Door → Vertical, Out, Red, Border 

Credit Roll → Timed, Wipe In/Out, on Black 

5  a.avi,  

 b.avi,  

 c.avi. 

3D Cascade → Left to Right 

3D Fly In/Out → Default 

Page Roll → Bottom-Left, Medium, Curl 

Credit Roll → Backward Scrolling, Primary 

Colors 

 


